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Safety Compliance

Safety Statement
This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60065 7th /IEC 60065 
7th and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

Important Safety Instructions
1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Only perform the services explicitly described in the install and or user manual.  For services or procedures not outlined in the install or user manual, speak with 
authorized service personnel.

6) Do not use this equipment near water.

7) Clean only with dry cloth.

8) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

9) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.

10) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug 
has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult 
an electrician for replacement of the obsolete outlet.

11) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.

12) Only use attachments/accessories specified by the manufacturer.

13) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a 
cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

14) Unplug this equipment during lightning storms or when unused for long periods of time. 

15) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is 
damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has 
been dropped.

16) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture. 

17) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type. 

18) The power inlet is the main disconnect device and should remain accessible. Disconnect the power cord before servicing the unit.

19) The equipment shall be used at a maximum ambient temperature of 40° C.

20) Disconnect power from mains before opening the product 
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Overview

This guide shows how to install the DNT-192 Dante Option Card in Stage 64 and Stage 32 I/O racks for Avid® VENUE | S6L sys-
tems. The DNT-192 Dante Option Card is a 16-channel audio interface card for communicating with Dante networks. Based on the 
Brooklyn II, the DNT-192 can be interfaced directly with any Gigabit Dante devices running compatible firmware. 

Each DNT-192 Dante Option Card occupies two slots in supported S6L Stage I/O units. Multiple DNT-192 Dante Option Cards 
can be installed in adjacent input or output slots for maximum input or output from each card. 

Stage 64 Each Stage 64 supports installation of up to eight input cards (or up to four DNT-192 cards) providing a maximum of 64 
input channels, and up to four output cards (or up to two DNT-192 cards) providing a maximum of 32 output channels. One 
DNT-192 card can be installed spanning Stage 64 input and output slots for “split” input and output from that single card. 

Stage 32  Each Stage 32 supports installation of up to four input and/or output cards (or up to two DNT-192 cards) providing a 
maximum of 32 input or output channels, or a combination of input and output cards up to the maximum of 32. 

DNT-192 Dante Option Card Features and Capabilities

Input and Output
Each DNT-192 card can be installed as an input-only, output-only, or (in Stage 64 only) as and input-and-output interface card. The 
number of channels of input and output vary with sample rate and Stage I/O unit slot location as shown in the following table. 

* In Stage 32, any and all input cards must be installed in lower-lettered slots than output cards. For example, a combination of an-
alog inputs and one DNT-192 card could be installed in the following slots on Stage 32:

When installed following this guideline (inputs first/above, outputs after/below) DNT-192 can be configured within VENUE soft-
ware to provide either 16 input channels or 16 output channels. If configured for output, all cards below it must also be output cards.

DNT-192 Dante Option Card IO capabilities and slot requirements, per sample rate

Sample Rate Input Output Stage 64 Slots Stage 32 Slots

48 kHz

16 0 Slots A through H Slots A through D*

8 8 Slots H and J only n/a

0 16 Slots J through M Slots A through D*

96 kHz

16 0 Slots A through H Slots A through D*

8 8 Slots H and J only n/a

0 16 Slots J through M Slots A through D*

192 kHz

8 0 Slots A through H Slots A through D*

4 4 Slots H and J only n/a

0 8 Slots J through M Slots A through D*

Example Stage 32 Slot Assignment

Card Stage 32 Slots

SRI (analog input card) Slot A

SRI (analog input card) Slot B

DNT-192 (configured for output) Slots C and D
 Overview 1



Control and Other Capabilities
• Dante controller software is used to configure the cards, monitor health and status, and perform network routing. Dante Con-

troller is available at https://www.audinate.com/products/software/dante-controller.
• The Dante device firmware is field upgradeable, using the Audinate Firmware Update Manager (www.audinate.com).
• Auto-Mute on power up and power down. Outputs can also be manually muted via VENUE software.
• Sample Rate Conversion can be enabled or disabled. SRC supports all Dante sample rates, including pull up and pull down.
• Support multicast and unicast operation, and all other functions and features provided by the Dante card.
• Auto-detection of card presence and I/O (based on slot installation) during Stage 64 initialization.

What’s Included
DNT-192 card packages include the following items:

• I/O card (DNT-192 Dante Option Card) 
• Health and Safety guide
• Avid Registration card
• Warranty claims card
• This guide (DNT-192 Dante Option Card Installation)

System Requirements and Compatibility
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. DNT-192 Dante 
Option Cards are compatible with Stage 64 I/O racks connected to VENUE | S6L systems running VENUE software 5.2 and higher. 
DNT-192 cards are also compatible with Stage 32 I/O racks connected to S6L systems running VENUE software 6.0 and higher.

For complete VENUE system requirements and other compatibility information, visit www.avid.com/compatibility.

For information about Dante and Audinate, visit https://www.audinate.com. 
DNT-192 Dante Option Card2



Conventions Used in This Guide
All of our guides use the following conventions to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

Convention Action

Options > System In the VENUE software, click Options to display the Options tab, then 
click the System tab.

File > Save Choose Save from the File menu.

Control+N Hold down the Control key and press the N key.

Control-click Hold down the Control key and click the mouse button.

Right-click Click with the right mouse button.

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other VENUE guides.
 Overview 3



Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. 
The following are just a few of the services and features available. 

Account Activation and Product Registration
Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your 
purchase online, download software, updates, documentation, and other resources. 

https://www.avid.com/account

Support and Downloads
Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Com-
patibility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on 
the User Conference. 

https://www.avid.com/products/venue-s6l-system/learn-and-support

Training and Education
Study on your own using courses available online, find out how you can learn in a classroom setting at an Avid-certified training 
center, or view a webinar. For example, check out the live sound webinars hosted by Robert Scovill: 

http://www.avid.com/live-sound-webinars

Also check out our Live Sound blogs: 

http://www.avidblogs.com/livesound/

Get started learning the ins and outs of S6L using the many Avid Live Sound videos on YouTube. 

Products and Developers
Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and 
hardware. 

https://www.avid.com/Products/index.html
DNT-192 Dante Option Card4
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DNT-192 Dante Option Card Hardware Overview

This section provides an overview of the connectors and indicators on the DNT-192 card.

DNT-192 Option Card Front Panel
The DNT-192 Option Card front panel provides the following indicators and connectors. 

SYSTEM LED  Indicates the status of the Dante system on this card.

SYNC LED  Indicates the clock synchronization status of the Dante device.

ERROR LED  Indicates status of the Dante Identify function. 

CONTROL Port  For connection to Windows or Mac computer running Dante Controller, for advanced 
card configuration options, status/monitoring and audio network routing. 

System LED color and indication

Color Indicates

Green All OK, sync achieved

Amber Booting up, awaiting sync

Not lit No power / fault

SYNC LED color and indication

Color Indicates

Green, solid Dante network clock slave, sync achieved

Green, flashing Dante network clock master, sync achieved

Amber Error achieving sync

Not lit No power / fault

Error LED color and indication

Color Indicates

Green, flashing Identify function activated

Not lit Identify function not activated (normal state)

LED Status Indicates

Link/Act LED Lit, solid Valid link detected

Lit, flashing Network traffic present

Not lit No valid link detected

Gigabit Lit, solid Gigabit connection detected

Not lit No Gigabit connection detected
 DNT-192 Dante Option Card Hardware Overview 5



PRIMARY Dante Port Ethercon connector with integrated LEDs for connecting to other Dante network devices.

SECONDARY Dante Port  Ethercon connector with integrated LEDs for connecting to other Dante network devices. At the time 
of this writing the SECONDARY port is not supported in VENUE configurations and should not be used. 

DNT-192 Option Card Back Panel
The back of the DNT-192 Dante Option Card features two ribbon connectors with latches. These receive Stage 64 / Stage 32 ribbon 
cables for each bank of DNT channels (whether input or output). 

The back also has two threaded holes that align with the Stage 64 / Stage 32 thumbscrews, to secure the back of the card to the in-
terior of the Stage 64. 

Important Note for Stage 32
If you plan to install a DNT-192 card into a Stage 32, make sure the DNT-192 has the correct bracket. The Stage 32-compatible 
bracket can be identified by its notch on the back, as shown below. 

Replacement brackets are available to retrofit original DNT-192 cards for installation into a Stage 32. To request a bracket, contact 
your dealer or Avid Customer Support. 

LED Color Indicates

Link/Act LED Lit, solid Valid link detected

Lit, flashing Network traffic present

Not lit No valid link detected

Gigabit Lit, solid Gigabit connection detected

Not lit No Gigabit connection detected

Stage 32 and Stage 64-compatible DNT-192 bracket (shown at left) and original, Stage 64-only (shown at right)
DNT-192 Dante Option Card6



Installing and Confirming DNT-192 Dante Option Cards

This section shows how to install a DNT-192 Dante Option Card in a Stage 64 or Stage 32 I/O rack and confirm installation. 

Prepare the I/O Rack Unit
Do the following to prepare your Stage 64 or Stage 32 for IO card installation: 

1 Shut down your VENUE system and power down your Stage 64 or Stage 32. 

2 Disconnect all cables from your Stage 64 or Stage 32. 

3 Remove the back panel: 

Stage 64  4Loosen the eight captive thumbscrews completely, using a #2 Philips screwdriver if necessary, and set the panel aside. 

Stage 32 Loosen the four captive thumbscrews completely, using a #2 Phillips screwdriver if necessary, and set the panel aside. 

5 Make sure your work area provides access to the front and back of the Stage IO unit. 

Figure 1. Stage 64 back panel captive thumbscrews

Stage 32 back panel captive thumbscrews

AC~100-240V;60-50HZ;2.0AAC~100-240V;60-50HZ;2.0A

DO NOT OBSTRUCT FANS
SERIAL NUMBER
 Installing and Confirming DNT-192 Dante Option Cards 7



6 For Stage 32 (only), do the following: 
• Facing the front, set the unit onto its right end as shown below. This position makes it easier to slide cards in and out. 

Installing DNT-192 Cards
After preparing the Stage IO unit you are ready to install cards. 

To install a DNT-192 card: 

1 On the front of the Stage IO unit, locate the slots where you want to install the input or output card. 
Each slot is lettered, and corresponds to the card slot shown along the top of the VENUE Patchbay patching grid. DNT-192 Dante 
Network cards can be installed in any two adjacent slots and configured in software as 16-in or 16-out. 
If configured for Dante output, all I/O cards below the DNT-192 card must be output cards. 
Observe the following requirements when installing the DNT-192 in Stage 64 or Stage 32: 

Stage 64  Slots are lettered left-to-right A–M. 
• Input Cards must be installed in slots A–H. For 16 channels of Dante input, DNT-192 cards must be installed in pairs of slots 

A–H (A+B, B+C, C+D, D+E, E+F, F+G, G+H). 
• Output Cards must be installed in slots J–M. For 16 channels of Dante output, DNT-192 cards must be installed in pairs of 

slots J–M (J+K, K+L, L+M)
• Input and Output (Stage 64 only): For 8 channels of Dante input and 8 channels of Dante output, a DNT-192 card must be in-

stalled in slots H+J. 

Stage 32 Slots are lettered from top-to-bottom A–D (when the unit is positioned in its standard orientation, with the AVID logo 
across the bottom). 

• Input cards are installed in lower lettered slots (physically above output cards). 
• Output cards are installed in higher lettered slots (physically below input cards). 
For example, if a DNT-192 card is installed in slots A and B and configured in VENUE software for 16 channels of Dante input, 
slots C and D can be filled with either input or output cards. If that same DNT-192 card is configured for 16 channels of Dante 
output, then slots C and D can only be filled with output cards. In Stage 32, DNT-192 cards cannot provide 8 in/8 out channels 
of Dante. 

Stage 32 positioned for IO card installation
DNT-192 Dante Option Card8



2 Do either of the following, as appropriate: 
• If the desired slot has a blank slot cover, remove the slot cover by unscrewing the two Philips head screws that secure the cover 

to the Stage IO unit. In the following image, the slot covers in slot G and H of a Stage 64 are highlighted.. 

If the desired slots already have IO cards installed, do the following to remove them: 
• From the front of the Stage IO unit, remove the thumbscrews securing each card to be removed. 
• From the back of the Stage IO unit, disconnect the ribbon cable connected to each card being removed by pushing the pair of 

latches outward (away from the connector) and then disconnecting the ribbon cable (see Figure 8). 
• From the back of the Stage IO unit, remove the captive thumbscrew(s) securing each card to the chassis (see Figure 7). 
• From the front of the Stage IO unit, gently slide the card(s) out. 

3 Remove the new I/O card from its packing material and hold the card by its edges. 

4 Make sure the latches on the ports on the back of the card are pushed inward (closed).

Figure 2. Blank Input slot covers on the front of a Stage 64

Figure 3. DNT-192 Dante Option Card showing brackets and connector 
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5 Gently slide the card into the slot (Figure 4): 
• Make sure that the card is oriented correctly in the unit, with the mounting guide pin and port at the top. 
• Make sure to insert the card straight so that it fits along the slot channel built into the unit. 

• Inside the back of the unit, make sure the pin at the top of the card aligns with the corresponding chassis guide hole (Figure 5).

Figure 4. Sliding the card into a Stage 64 (shown at left) and a DNT-192 card aligned with the interior channel in a Stage 32 (shown at right)

Figure 5. Guide pins and guide holes inside a Stage 64
DNT-192 Dante Option Card10



6 Push the card into the slot so it is flush with the front panel, and tighten the four captive thumbscrews on the front of the card 
to secure it to the Stage unit.

7 Inside the back of the Stage unit, tighten the two captive thumbscrews to secure the card to the chassis. 
Make sure the thumbscrews align with the threaded mounting holes on the back of the DNT-192 card. 

8 Inside the back of the unit, push the latches on the newly installed card outward (open).

If the card does not slide all the way into the slot, make sure the latches on the ports of the card are pushed fully inward.

Figure 6. Tightening one of the four front captive thumbscrews (Stage 64 shown)

You might need to disconnect some or all ribbon cables to access the thumbscrews. 

Figure 7. Securing a card to a Stage 64 chassis (shown at left) and a Stage 32 (shown at right)
 Installing and Confirming DNT-192 Dante Option Cards 11



9 Connect (or reconnect) ribbon cable(s). 
• Locate the corresponding ribbon cable (all ribbon cables are cut to length), and push the cable connector into the port on the 

card so that the latches on the port move inward and lock the connector to the port on the card. Double-check to make sure the 
card is connected securely. 

• If you had to disconnect other ribbon cables, re-connect them starting with the first (shortest) ribbon cable.

10 Replace the back panel on the Stage 64 or Stage 32:

Stage 64  Make sure to properly orient the panel, align the back panel guide pins to the guide holes, and secure it to the Stage 64 
by tightening the captive thumbscrews. 

Stage 32  Align the back panel and secure it to the Stage 32 by tightening the captive thumbscrews.

11 Proceed to “Confirming Installation” on page 13.

Figure 8. Connecting ribbon cable in a Stage 64 (shown at left) and Stage 32 (shown at right) Your installation may appear differently 
depending on the slots used for the DNT-192 card)

Figure 9. Back panel guide pins (Stage 64 only)
DNT-192 Dante Option Card12



Confirming Installation
After you have installed an I/O card, you should confirm that you have installed it properly.

To complete and confirm installation:

1 Connect the power cables to the Stage unit and to a power source.

2 Connect the Stage unit to the rest of your S6L system.

3 Power on your Stage unit and the rest of the components of your S6L system.

4 In the VENUE software screen, go to the Options > Devices page.

5 In the Available Devices or Connected Devices columns, tap the icon of the Stage 64 or Stage 32 in which you installed the 
DNT-192 card so it is highlighted in blue.

6 Under Information, tap Settings. The card slots of the selected Stage unit are listed, showing the cards that are currently in-
stalled. Slots without cards are indicated as empty. 
The newly installed Stage I/O card should appear in the slot in which you installed the card.

For instructions on using the Stage 64 and Stage 32, including how to designate DNT-192 cards in a Stage 32 for input or out-
put, see the VENUE | S6L System Guide.pdf, included with the S6L system software in your Avid account.
 Installing and Confirming DNT-192 Dante Option Cards 13
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Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste 
equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more 
information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the 
product.

Proposition 65 Warning

Perchlorate Notice
This product may contain a lithium coin battery. The State of California requires the following disclosure statement: 
“Perchlorate Material – special handling may apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

EMC (Electromagnetic Compliance)
This model complies with the following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55022 Class B
• EN 55024 Class B
• AS/NZS CISPR 22 Class B
• CISPR 22 Class B

This product contains chemicals, including 
lead, known to the State of California to 
cause cancer and birth defects or other re-
productive harm. Wash hands after handling.
 Compliance Information 15



FCC Compliance for United States

Radio and Television Interference

Australian Compliance

Canadian Compliance
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

CE Compliance
(EMC, Safety, and ROHS)

Avid is authorized to apply the CE (Conformite Europenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC, Low Voltage 
Directive 2006/95/EC and RoHS Directive 2011/65/EC.. 

Korean EMC Compliance

Communication Statement
NOTE: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular 
installation.  If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try and correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, 
could void the user's authority to operate the equipment.
DNT-192 Dante Option Card16
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75 Network Drive
Burlington, MA 01803
Technical Support (USA)
Visit the Online Support Center 
at www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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